## Table of Contents

### Introduction
- General .............................................................. 5
- Use of this Manual .................................................. 6
  - About this Manual .................................................. 6
  - System Overview .................................................... 7

### CCC User Access
- Starting CCC User Access ........................................... 9

### Delta Server
- Introduction ............................................................ 10
- Viewing Delta Server ................................................ 11
- Tool Bar Pane
  - Introduction .......................................................... 12
  - Event Viewer ........................................................ 13
  - Event Viewer Selector .............................................. 14
  - Email Notification .................................................. 15
  - Log to File ............................................................ 16
  - SMDR ................................................................. 17
  - Comms ................................................................. 18
  - Message Control .................................................... 19
  - PCA Target Times .................................................. 20
  - Users ................................................................. 21
  - Users (Active) ......................................................... 21
  - Agents ................................................................. 22
  - Agents (Logged Off) ............................................... 23
  - Agents (Logged on) ................................................ 23
  - Agents (Active) ....................................................... 23
  - Agents (Available) ................................................ 24
  - Agents (Located) ................................................... 24
  - Recent SMDR Entries .......................................... 25
  - License Info .......................................................... 26
  - Session Info .......................................................... 27
  - Group ................................................................. 28
  - Group Active ........................................................ 28
  - Pilot Number ......................................................... 29
  - Lines ................................................................. 29
  - Lines (Active) ......................................................... 30
  - Calls ................................................................. 30
  - Archiver ............................................................... 31

### Reporting Admin Console
- Launching Reporting Admin Console ......................... 33
- PBX Tab ............................................................... 33
- Database Tab .......................................................... 34
- CRM Tab ............................................................... 35
- Email Tab ............................................................. 35
- Service Tab ........................................................... 36

### Database Server Supervisor
- Starting ................................................................. 37
- Changing the Server Connection ................................ 37
- User Interface
  - Options Pane ....................................................... 38
  - Archiver Maintenance Plan ...................................... 40
  - General Tab .......................................................... 40
  - Optimization Tab .................................................. 41
  - Integrity Tab .......................................................... 42
### Table Of Contents

- Complete Backup Tab ................................................................. 43
- Transaction Log Backup Tab ...................................................... 44
- Reporting Tab ............................................................................ 45
- Edit Recurring Job Schedule .................................................... 47
- Backups & Restoring ................................................................. 48
  - The Backup Wizard ................................................................. 48
  - Edit Schedule Screen ............................................................ 49
  - Manual Backups ..................................................................... 50
  - Restoring a Database ............................................................. 52
- General Information ................................................................. 54
  - Display Error Logs ................................................................. 54
  - Viewing Messages ............................................................... 55
  - Jobs ....................................................................................... 56
  - Backup Devices ...................................................................... 57
  - Properties .............................................................................. 58
- Administering the Database ..................................................... 63
  - Overview ............................................................................... 63
  - Disk Backup .......................................................................... 63
  - Integrity Check ....................................................................... 63
  - Optimizations ....................................................................... 63
  - Restore .................................................................................. 63
  - Tape Backup .......................................................................... 63
- Index ......................................................................................... 65
Introduction

General

Compact Contact Center (CCC) modules provide the user with the necessary tools to facilitate the management of call traffic. These tools are designed to provide a tightly integrated real time and historic reporting package and wallboard support for the eBusiness digital communications platform. The product consists of a set of fully integrated modules sharing a common database utilising Interactive Directory and Database (IDD) technology.

The suite of modules consists of the following applications:

- **Call Center View (CCV):** Provides a management package for telephone based staff and supports any size Customer Facing Department (CFD) or contact center. To effectively control customer service levels, real time human resource management is essential and the Call Center View has been specially designed to manage the CFD’s or contact center’s most valuable and expensive asset – it's people.

- **Call Center View Alarm Reporter:** Provides information (for each Contact Center Profile) about alarms that have occurred within the Compact Contact Center. The detailed alarm information for each directory number is presented in report format, which can then be printed.

- **Wallboard Manager:** Real time information from the call center is essential to react to constantly changing telephone traffic levels and provide excellent customer service. Wallboards allow managers and staff to monitor the service being provided and respond immediately. Wallboards provide current information on the number of calls waiting, response times and service levels. Wallboard Manager provides the ability to drive physical wallboards and PC wallboards.

- **PC Wallboard:** The PC Wallboard delivers traditional wall mounted wallboard functionality to the desktop but with the additional benefit of each PC Wallboard agent being able to configure and monitor a personalised view of the contact center. The PC Wallboard also enables agents to increase their productivity and maintain revenue levels with the added benefit of managing customer callback requests.

- **Reporter:** This module provides in depth historical reporting on contact center activity. In addition to call centre information, the Reporter also provides reports individual agent activity. This powerful package allows individual call records to be stored and reported upon months later.

- **CCC User Access:** CCC User Access allows storage of personal Call Center View and Wallboard settings. It also establishes user rights and password protection for Call Center View, Wallboard and Alarm Reporter software.

- **Workforce Management – Blue Pumpkin:** Workforce Management Interface allows integrated rostering, forecasting and scheduling systems to connect across the LAN to a comma separated variable (CSV) file containing a list of Contact Center related metrics.

- **MultiMedia Module:** The MultiMedia Module (MMM), is a customer contact software solution that enables companies and departments to manage multimedia contacts into and out of the organization. MMM provides applications that manage Telephony, Web Chat, E-mail and Web Call Back communications.

For installation and administration of the MultiMedia Module, refer to the separate set of manuals for MultiMedia.
Use of this Manual
This manual covers the installation and administration of Avaya's Compact Contact Center (CCC) at software Level 5.0+. on the following communications platforms:

- IP Office operating Software Level 2.0+

This guide is intended for use by installers and administrators who are familiar with the relevant communications platform and have successfully completed the appropriate training courses.

Ensure that you have read and understood this Manual before beginning installation.

About this Manual
This manual is designed for the CCC System Administrator and provides the information necessary to access, configure and administer the CCC system.

This manual contains information on:

- CCC User Access - see page 9.
- Delta Server - see page 10.
- Database Server Supervisor - see page 37.
- Administering the Database - see page 63.
- Reporting Admin Console - see page 33.
System Overview

Compact Contact Center provides the user with the necessary tools to facilitate the management of call traffic. The following conceptual diagram shows how this is achieved:

The Compact Contact Center consists of the following components:

- **Telephone System**: The telephone system software must be IP Office Level 2.1+
- **Delta Server**: This component connected to both the telephone system and to the MultiMedia Module. The **Archiver** obtains and accumulates the information from the IP Office via the Delta Server.
- **CCC User**: This component communicates with the Delta Server to provide User Access Level as well as Password Protection for the CCC modules.
- **Call Center View**: This component communicates with the Delta Server to enable the user to monitor, in real time, selected Contact Center activity.
- **Wallboard Manager**: This component communicates with the Delta Server enabling the user to display selected Contact Center activity on a wallboard device.
- **Report Server**: This application communicates, via Archiver/Delta Server, with the SQL database and enables you to define, run and schedule the available standard reports.
CCC User Access

Starting CCC User Access

CCC User Access is available on all Server and Client PCs. It allows storage of personal Call Center View profiles and Wallboard settings.

Initially, on each PC, Administrators can log on by entering the following:

Name: Admin           Password: NMYSBH

CAUTION: When you log on as Administrator for the first time, it is recommended that you change the password. The new password must be recorded and kept in a secure place.

As an administrator you have the ability to change all set up screen and run the CCV Alarm Reporter application.

You can also log on with any name and no password is required. As you are not logged on as an administrator, CCV Alarm Reporter cannot be run and the following setup screens are not available.

- WB Alarm Scripts
- Alarm WB Destination
- Alarm Settings
- Default Settings.

To log on using CCC User Access:

1. Double click on the CCC User Access Icon showing on the toolbar. If this is not visible double click the same Icon on the desktop and then double click on the toolbar Icon (which should now be visible).

2. A CCC User Access screen will be shown. For Administrator rights the User Name must be Admin. A password box will appear. Enter the default password (NMYSBH) and the Update button will become active. Click on it to update the user identification.

3. The new password must be recorded and kept in a secure place. To change the password, click on the New Password button, enter your new password and confirm the change.

4. When you have logged on as either Administrator or Supervisor, the status will appear at the bottom of the CCV task bar as follows:
Delta Server

Introduction

The Delta Server receives the IP Office call data via the LAN. The Delta Server is a component to which all the CCC modules connect. It is able to support up to 80 simultaneous client connections (e.g. CBC, CCV, etc.) and consists of software that ensures every activity on the telephone system is passed through to these modules. An example of an activity could be that an agent has 'logged on' which would clearly impact the real time Call Center View and the Wallboard Manager software.

The Delta Server additionally holds a model of the IP Office such that each time a new CCC module is started it will synchronise itself with today’s data, thus ensuring consistency between clients irrespective of when they were started.

The Delta Server application runs as a Windows Service.
Viewing Delta Server
You need to ensure the Delta Server has established connection with the telephone system. Every time the Server PC is switched on, the Delta Server starts up automatically. You can view the Delta Server, by performing the following:-

1. Click the Start button on the Windows Taskbar.
2. Point to Programs | CCC.
4. Click on Comms in the Toolbar Pane and the following screen appears:

The information on the screen is:

**Comms Status**: This indicates the status of the link between the Delta Server and the telephone system. These are:

- **Comms Restored**: Indicates the connection between the Delta Server and the telephone system is established.
- **Init Comms**: Indicates Delta Server is initializing and has established communication with the telephone system (this happens every time you start the Delta Server).
- **Comms Failure**: Indicates communications link between the Delta Server and the telephone system has been terminated.

The name and the IP Address of the IP Office are displayed when connection has been established.

If the Comms Status does not show Comms Restored, click on Apply and Refresh. The name and IP Address of the IP Office will appear in the Connection window.

**Toolbar Fields**: The Event Viewer, Event Viewer Selector, Email notification, Log to File, SMDR, Comms, etc. enable access to their display field menus.
Tool Bar Pane

Introduction
The tool bar pane (on the left hand side of the display) lists all the available diagnostics and set up menus available in the Delta Server.

Details on the menus available are:

- Event Viewer - page 13.
- Event Viewer Selector - page 14.
- Email Notification - page 15.
- Log to File - page 16.
- SMDR - page 17.
- Comms - page 18.
- Message Control - page 19.
- PCA Target Times - page 20.
- Users - page 21.
- Users (Active) - page 21.
- Agents - page 22.
- Agents (Logged On) - page 23.
- Agents (Logged Off) - page 23.
- Agents (Active) - page 23.
- Agents (Available) - page 24.
- Agents (Located) - page 24.
- Recent SMDR Entries - page 25.
- Session Info - page 27.
- Group - page 28.
- Group (Active) - page 28.
- Pilot Number - page 29.
- Lines - page 29.
- Lines (Active) - page 30.
- Calls - page 30.
- Archiver - page 31.
Event Viewer

The Event Viewer displays communication messages between the Delta Server and the CCC Module Client application(s). It can also show messages received from the connected CCC modules. In default, Event Viewer displays Error Messages. To update the Events screen, click on Refresh.

---

Certain Events will always be displayed even if you have not selected any specific options for viewing. Such Events are:

- Comms Failure.
- License Requests.
- Message Routing Failure.

These events can be changed using the Event Viewer Selector. In addition you can also configure your e-mail notification, where your Error Log and Delta Server event stream (SMDR) files are to be stored.
Event Viewer Selector
This menu allows you to add or delete events that are displayed in the Event Viewer.

The significance of the tick boxes are:

- **Error**: Provides error/warning/feedback messages from both IP Office and CCC modules.
- **Delta Info**: Provides Delta messages to Client Applications (in real time) that originate from the IP Office.
- **Server**: Provides events data from the IP Office and data for archiving (historical).
- **Timer**: Displays all timed events between IP Office and CCC modules.
- **Initialise**: Every time the Delta Server is initialised, the date, time, etc. is displayed.
- **Network**: Provides identity data of network you are connected to.
- **CTI Message**: Provides integration messages to/from the IP Office.
- **R17 Message**: Provides internal CCC module messages.
- **Client Message**: Provides messages from Client(s), e.g. Wallboard, sign on/off, Archiver, etc.
- **Delta 2 Message**: Provides messages from IP Office, e.g. call information.
- **MultiMedia Message**: Provides messages from the (optional MMM module (see separate manual for details)
- **SMDR Message**: Provides messages to/from CCC modules (in SMDR format) to/from IP Office.

When you have ticked your selection(s), click on the Apply button.

**Note**: Selecting a large number of fields will impact on the Delta Server’s performance.
Email Notification
You can automatically receive notification by email when a problem occurs with the Delta Server connection to the IP Office. With Email Notification selected, the following menu is displayed:

The significance of the tick boxes and display areas are:

- **Enable Email Notification**: Tick if email notification is required.
- **Recipients**: Enter the email address of the recipient to whom the email is to be sent. When more than one person is required to receive notification, enter all the email addresses into the field. A semi colon should be used to separate each address.
- **Additional Text**: Adds data to email concerning PC that Delta Server is operating from, e.g. IP Office configuration, RAM, Applications, etc.
- **Attach Switch Configuration**: Attaches the current switch configuration to email.
- **Attached Voice Mail Configuration file**: Adds VMPro Database information to email.
- **Attach current Delta Server log file**: Adds log file to email.

When you have ticked your selection(s), click on the Apply button.

- **Test Email**: Sends email to address entered in Recipients box above together with any data/files requested in the tick boxes.

**Note**: The more boxes ticked the bigger the email becomes, especially the VMPro and Delta Server logs.
Log to File
The Delta Server log file is used for diagnostic purposes. If there is an error the file can be emailed to selected recipients to notify them of a problem. With Log to File selected, the following menu is displayed:

- **Log File Enabled**: Tick if you wish to enable Log to File.
- **Log File Name**: Displays the name of the file path and the name of the file.

When you have ticked your selection(s), click on the Apply button.
SMRD

The IP Office Station Message Detail Recording (SMRD) functionality captures detailed information about incoming and outgoing voice and data calls. It receives SMRD data via the LAN. The SMRD log file for the present day is named SMRD.csv. At midnight the log file will be automatically rolled over and renamed to the date of the log.

  Present Day: SMRD.csv
  Previous Day: SMRD(backupYYYY-MM-DD).csv

The SMRD.csv file can be accessed by 3rd party applications whilst been used by the SMRD (Delta Server) application. In order to do this, the 3rd party application must open the SMRD.csv file for read only, and should process as many records as are found. The application may either read the entire file periodically and determine what new records have been output since last accessed, or periodically read from the current position until the end of the file.

With SMRD selected, the following menu is displayed:

---

**Delta Server**

Comms Status : Init Comms

**SMRD**

- SMRD Log File Enabled: Tick if you wish to enable the SMRD Log File.
- SMRD Log File Name: Displays the name of the file path and the name of the file. You may change this from the default if you so wish.
- SMRD Port Enabled: Tick if you wish to enable Log to File. The SMRD default port number is displayed. You may change this from the default if you so wish.
- SMRD Port will act as a client: Tick if you wish the SMRD port to act as a client. Enter the remote host IP address for the SMRD client.
- Send Data every and Send Data at: Select, from the pull down list, the time interval for sending SMRD files.

When you have ticked your selection(s), click on the Apply button.
Comms
This screen displays details of both the telephone system and the Multimedia Modules to which the Delta Server is connected.

The information on the screen is:

**Comms Status**: This indicates the status of the link between the Delta Server and the telephone system. These are:

- **Comms Restored**: Indicates the connection between the Delta Server and the telephone system is established.
- **Init Comms**: Indicates Delta Server is initialising and has established communication with the telephone system (this happens every time you start the Delta Server).
- **Comms Failure**: Indicates communications link between the Delta Server and the telephone system has been terminated.

The name and the IP Address of the IP Office are displayed when connection has been established. If the Comms Status does not show Comms Restored, click on Apply and Refresh. The name and IP Address of the IP Office will appear in the Connection window.

**Connection**: Displays the name and IP Address of the IP Office connected to the Delta Server. If not shown, enter the IP Address in the Search box and click Search.

**Connection to MultiMedia Module**: Tick this box if connection to the MultiMedia Module is required (the MMM Resource Manager should be running). In the MultiMedia Connection box, enter the name or the IP Address of the Server running the MultiMedia module.

When you have entered your selection(s), click on the Apply and Refresh buttons.
Message Control

Time in Activity (TIA) are messages that are produced by the Delta Server which are subsequently transmitted to the Archiver.

The information on the screen is:

- **Refresh**: Tick to refresh
- **Auto Reset Time**: Enter the time in which you wish to have the real time statistics reset (default 00.00).
- **Lost Email Threshold (days)**: This option is here for maintenance only. Do not use this option, but set up the threshold from the CCV.
- **Enable Closing Time**: Tick and the enter the required time, in the Company Closing Time box, that the Call Center ceases work.
- **Display Agent Details**: These features are designed solely for the German Market and are only active if German is the selected language for installation. When ticked, details of individual agents are displayed, e.g. names, statistics, etc.
- **Agent Group TIA's Enabled**: Enables the generation of TIA's for Agent Groups respectively. This will affect Agent Activity trace i.e. you will not be able to see how long agents are in state. This is disabled by default.
- **Trunk Group TIA's Enabled**: Enables the generation of TIA's for Trunk Groups respectively.
- **Voicemail Group TIA's Enabled**: Enables the generation of TIA's for Voicemail groups. This allows the voicemail reports to show when all the voicemail channels are busy.
- **Selective ISMDR Suppression On**: Enables/disables internal SMDR reports historically.
- **Display Agents**:
  - **All Agents**: When ticked, details of all extensions on the switch are considered as agents.
  - **Login by Code**: When ticked, Force Login is not required to be set in the switch. However, a login code is still required to enable extensions to be considered as agents.

**Note**: Disabling the generation of TIA's will reduce the amount of data stored in the Archiver database. However, it should also be noted that this would disable Time In State fields for respective groups on historical reports i.e. more summary information and less detail.
PCA Target Times
Displays the setting used to calculate the PCA, e.g. the minimum time (in seconds) an agent is permitted to leave a call ringing. You can alter these default times (default 45 seconds). The list of individual agents are shown below any hunt groups that have been created.

<table>
<thead>
<tr>
<th>System Group</th>
<th>Time (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tech</td>
<td>45</td>
</tr>
<tr>
<td>Sales</td>
<td>45</td>
</tr>
<tr>
<td>Cust</td>
<td>45</td>
</tr>
<tr>
<td>Ext2201</td>
<td>45</td>
</tr>
<tr>
<td>Ext2208</td>
<td>45</td>
</tr>
<tr>
<td>Ext2217</td>
<td>45</td>
</tr>
<tr>
<td>Ext2218</td>
<td>45</td>
</tr>
<tr>
<td>Ext2219</td>
<td>45</td>
</tr>
<tr>
<td>Ext2220</td>
<td>45</td>
</tr>
<tr>
<td>Ext2247</td>
<td>45</td>
</tr>
<tr>
<td>Ext2248</td>
<td>45</td>
</tr>
<tr>
<td>Ext2249</td>
<td>45</td>
</tr>
<tr>
<td>Ext2280</td>
<td>45</td>
</tr>
<tr>
<td>IP Soft</td>
<td>45</td>
</tr>
</tbody>
</table>

When you have changed the time(s), click on **Apply**.
Users
Displays diagnostic data on all extensions on the IP Office.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Directory Number</th>
<th>Location</th>
<th>Voice Mail</th>
<th>Queue Details</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brian</td>
<td>Agent</td>
<td>206</td>
<td>2.11</td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Charles</td>
<td>Agent</td>
<td>206</td>
<td>2.15</td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>DECT201</td>
<td>Extension</td>
<td>201</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>DECT202</td>
<td>Extension</td>
<td>202</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>DialIn</td>
<td>Extension</td>
<td>2096</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Extn208</td>
<td>Extension</td>
<td>208</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Extn209</td>
<td>Extension</td>
<td>209</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Extn210</td>
<td>Extension</td>
<td>210</td>
<td></td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Fred</td>
<td>Agent</td>
<td>203</td>
<td>2.3</td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>James</td>
<td>Agent</td>
<td>207</td>
<td></td>
<td></td>
<td></td>
<td>CMCSLogged</td>
</tr>
<tr>
<td>John</td>
<td>Agent</td>
<td>204</td>
<td>2.7</td>
<td></td>
<td></td>
<td>CMCS Idle</td>
</tr>
<tr>
<td>Nouser</td>
<td>Extension</td>
<td>8998</td>
<td></td>
<td></td>
<td></td>
<td>CMCSLogged</td>
</tr>
</tbody>
</table>

Users (Active)
Displays diagnostic data on all active extension on the IP Office

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Directory Number</th>
<th>Location</th>
<th>Voice Mail</th>
<th>Queue Details</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brian</td>
<td>Agent</td>
<td>205</td>
<td>2.11</td>
<td></td>
<td></td>
<td>CM</td>
</tr>
<tr>
<td>Charles</td>
<td>Agent</td>
<td>206</td>
<td>2.15</td>
<td></td>
<td></td>
<td>CM</td>
</tr>
<tr>
<td>Fred</td>
<td>Agent</td>
<td>203</td>
<td>2.3</td>
<td></td>
<td></td>
<td>CM</td>
</tr>
</tbody>
</table>

**Note:** When hotdesking is being used the type is Agent and the location is shown. In normal use the type is Extension and the location is blank.
Agents
Displays diagnostic data on all agents within the agent group.

To obtain more details about a particular agent, double click on the agent's name to view the Delta Diagnostics screen.

Delta Diagnostics

0  Name        Extn2201
  1  External Dn  2201
  2  Status       2
  3  Device Type  46
  4  Group Act    T
  16  Data Logon  040611
  17  Time Logon  101604
  18  Data Logoff 040611
  19  Time Logoff 095720
  20  Agent Act   T
  23  Last Rexd CLI  2217
  41  All Go Pres  3
  112  Sp Inc CR  0
  113  Gp Inc CR  0
  114  In Trk Call Rate  0
  115  Out Call Rate  0
  120  Aband Call Rate  0
  123  In Other CR  0
  130  Dstr Last State Change  040611
  131  Time Last State Change  101644
  134  MSIT Ready  112
  140  MSIT Ringing  48
  233  All Calls Refused  3
  234  GT Terms All Calls Refused  3

Delta Server Version 5.0.5
Agents (Logged Off)
Displays diagnostic data on all the logged off agents.

![Agents Diagnostics]

Agents (Logged on)
Displays diagnostic data on all the logged on agents.

![Agents Diagnostics]

Agents (Active)
Displays diagnostic data on all the active agents.

![Agents Diagnostics]
Agents (Available)
Displays diagnostic data on all the available agents.

Agents (Located)
Displays diagnostic data on all agents who have a physical extension location.
## Recent SMDR Entries

Displays diagnostic data on the most recent SMDR received data

### Delta Server

Comms Status: Comms Restored

[refresh]

### SMDR Diagnostics

<table>
<thead>
<tr>
<th>Time of Call Arrival</th>
<th>Call Duration</th>
<th>Rice Time</th>
<th>CLN</th>
<th>SDI</th>
<th>CO1</th>
<th>Account Code</th>
<th>Internal Call ID</th>
<th>More</th>
<th>SLID</th>
<th>PI Name</th>
<th>ES ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004/03/12 16:42:32</td>
<td>00:00:06</td>
<td>0</td>
<td>204</td>
<td>O</td>
<td>205</td>
<td>205</td>
<td>0</td>
<td>18</td>
<td>O</td>
<td>E204</td>
<td>John</td>
</tr>
<tr>
<td>2004/03/12 16:42:32</td>
<td>00:00:00</td>
<td>0</td>
<td>204</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>1</td>
<td>E204</td>
<td>John</td>
</tr>
<tr>
<td>2004/03/12 16:42:29</td>
<td>00:00:01</td>
<td>2</td>
<td>206</td>
<td>O</td>
<td>205</td>
<td>205</td>
<td>1</td>
<td>19</td>
<td>O</td>
<td>E205</td>
<td>Brian</td>
</tr>
<tr>
<td>2004/03/12 16:42:14</td>
<td>00:00:00</td>
<td>4</td>
<td>203</td>
<td>O</td>
<td>204</td>
<td></td>
<td>0</td>
<td>15</td>
<td>O</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 16:42:14</td>
<td>00:00:00</td>
<td>0</td>
<td>203</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>17</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 16:41:51</td>
<td>00:00:04</td>
<td>2</td>
<td>206</td>
<td>O</td>
<td>205</td>
<td>205</td>
<td>1</td>
<td>15</td>
<td>1</td>
<td>E205</td>
<td>Brian</td>
</tr>
<tr>
<td>2004/03/12 16:41:59</td>
<td>00:00:01</td>
<td>2</td>
<td>205</td>
<td>O</td>
<td>203</td>
<td>203</td>
<td>1</td>
<td>16</td>
<td>0</td>
<td>E205</td>
<td>Brian</td>
</tr>
<tr>
<td>2004/03/12 16:41:40</td>
<td>00:00:07</td>
<td>2</td>
<td>205</td>
<td>O</td>
<td>204</td>
<td>204</td>
<td>1</td>
<td>14</td>
<td>0</td>
<td>E205</td>
<td>Brian</td>
</tr>
<tr>
<td>2004/03/12 16:41:34</td>
<td>00:00:12</td>
<td>2</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>13</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 16:15:16</td>
<td>00:01:30</td>
<td>4</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>204 1111</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>E204</td>
<td>John</td>
</tr>
<tr>
<td>2004/03/12 16:15:16</td>
<td>00:00:24</td>
<td>4</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203</td>
<td>1</td>
<td>10</td>
<td>1</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 11:30:47</td>
<td>00:12:13</td>
<td>8</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>8</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 09:01:48</td>
<td>01:48:21</td>
<td>34</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>6</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 09:36:42</td>
<td>00:00:35</td>
<td>4</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>4</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 09:34:04</td>
<td>00:00:18</td>
<td>1</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>2</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
<tr>
<td>2004/03/12 09:00:52</td>
<td>00:00:54</td>
<td>4</td>
<td>206</td>
<td>O</td>
<td>203</td>
<td>203 1111</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>E203</td>
<td>Fred</td>
</tr>
</tbody>
</table>
License Info

This screen displays the number of licenses within the CCC Modules.

- **Total Available**: This indicates the total number of agent licenses.
- **Number Remaining**: Number remaining. As each agent logs on, the number decreases. Also applies to Client applications, e.g. Call Center View, Wallboard Server, etc.

<table>
<thead>
<tr>
<th>License Info</th>
<th>Total Available</th>
<th>Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents</td>
<td>255</td>
<td>25</td>
</tr>
<tr>
<td>Call Center View</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Wallboard Server</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>Archiver</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>PC Wallboard</td>
<td>255</td>
<td>25</td>
</tr>
<tr>
<td>Report Viewer</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Report Designer</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>CBC</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>DeltaView</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Workforce Management: Blue Pumpkin</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>Spectrums</td>
<td>255</td>
<td>25</td>
</tr>
<tr>
<td>Chat</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Email</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Delta Server Version 5.0.1*

Page Created: March Wednesday 24 2004 15:50:58
Session Info

This displays the application(s) currently connected to the Delta Server, their activity and their licences. A total of 80 applications can be connected to the Delta Server. The following information is provided as each application is connected to the Delta Server.

- **Session**: The number of the application
- **Start Time**: The date and time of the session.
- **Session Type**: Indicates the name of the application that is connected.
- **Machine Name**: The name of the PC hosting the application.
- **User Name**: The name used when the client application was run.
- **UE’s Required (Yes/No)**: Indicates whether a session has requested Unsolicited Events.
- **Nbr of Re Trans (0-10)**: Indicates how well the application is responding to probes between the application and Delta Server. Any number greater than 0 could indicate there is a network problem.
- **Nbr Consumed Lics**: Indicates the number of Licenses consumed.
- **Licenses Consumed**: List (in pairs) of consumed licenses.
- **PC Wallboard Licenses**: Number of Active PC Wallboard License(s) used in this session.

### Session Info Table

<table>
<thead>
<tr>
<th>Session</th>
<th>Start Time</th>
<th>Session Type</th>
<th>Machine Name</th>
<th>User Name</th>
<th>UE’s Required</th>
<th>Nbr of Re Trans</th>
<th>Nbr Consumed Lics</th>
<th>Licenses Consumed</th>
<th>PC Wallboard Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>3/15/2004 09:50:03</td>
<td>ARCHIVER</td>
<td>ACMESERVER Administrator</td>
<td>Yes</td>
<td>0</td>
<td>1</td>
<td>12</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>3/20/2004 12:56:30</td>
<td>Wallboard Server</td>
<td>ACMESERVER Administrator</td>
<td>No</td>
<td>0</td>
<td>1</td>
<td>12</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>26</td>
<td>3/23/2004 13:13:18</td>
<td>QMS</td>
<td>ACMECLIENT Administrator</td>
<td>No</td>
<td>0</td>
<td>1</td>
<td>20</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Delta Server Version 5.0.1
Page Created: March Wednesday 24 2004 15:51:11
Group
Displays diagnostic data on all of the Hunt Group set up in the IP Office.

Group Active
Displays diagnostic data on all of the active agents with the Hunt Group set up in the IP Office.
Pilot Number
Displays diagnostic data on all of the Pilot Numbers set up in the IP Office.

<table>
<thead>
<tr>
<th>Time</th>
<th>Remote</th>
<th>Type</th>
<th>Device Number</th>
<th>Location</th>
<th>Call C Su/Spd</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pilot Number 2201</td>
<td>Dect One</td>
<td>Pilot Number</td>
<td>8201</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2202</td>
<td>Ext 2202</td>
<td>Pilot Number</td>
<td>8202</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2203</td>
<td>Ext 2203</td>
<td>Pilot Number</td>
<td>8203</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2204</td>
<td>Ext 2204</td>
<td>Pilot Number</td>
<td>8204</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2205</td>
<td>Ext 2205</td>
<td>Pilot Number</td>
<td>8205</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2206</td>
<td>Ext 2206</td>
<td>Pilot Number</td>
<td>8206</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2207</td>
<td>Ext 2207</td>
<td>Pilot Number</td>
<td>8207</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2208</td>
<td>Ext 2208</td>
<td>Pilot Number</td>
<td>8208</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2209</td>
<td>Ext 2209</td>
<td>Pilot Number</td>
<td>8209</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2210</td>
<td>Ext 2210</td>
<td>Pilot Number</td>
<td>8210</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2211</td>
<td>Ext 2211</td>
<td>Pilot Number</td>
<td>8211</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2212</td>
<td>Ext 2212</td>
<td>Pilot Number</td>
<td>8212</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2213</td>
<td>Ext 2213</td>
<td>Pilot Number</td>
<td>8213</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2214</td>
<td>Ext 2214</td>
<td>Pilot Number</td>
<td>8214</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2215</td>
<td>Ext 2215</td>
<td>Pilot Number</td>
<td>8215</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2216</td>
<td>Ext 2216</td>
<td>Pilot Number</td>
<td>8216</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2217</td>
<td>Ext 2217</td>
<td>Pilot Number</td>
<td>8217</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2218</td>
<td>Ext 2218</td>
<td>Pilot Number</td>
<td>8218</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2219</td>
<td>Ext 2219</td>
<td>Pilot Number</td>
<td>8219</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2220</td>
<td>Ext 2220</td>
<td>Pilot Number</td>
<td>8220</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2221</td>
<td>Ext 2221</td>
<td>Pilot Number</td>
<td>8221</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2222</td>
<td>Ext 2222</td>
<td>Pilot Number</td>
<td>8222</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2223</td>
<td>Ext 2223</td>
<td>Pilot Number</td>
<td>8223</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pilot Number 2224</td>
<td>Ext 2224</td>
<td>Pilot Number</td>
<td>8224</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Lines
Displays diagnostic data on all of the exchange lines to the IP office.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Device Number</th>
<th>Location</th>
<th>Call C Su/Spd</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRI Line 5</td>
<td>9260</td>
<td>0.1</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.1</td>
<td>9261</td>
<td>0.2</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.2</td>
<td>9262</td>
<td>0.3</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.3</td>
<td>9363</td>
<td>0.4</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.4</td>
<td>9564</td>
<td>0.5</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.5</td>
<td>9665</td>
<td>0.6</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.6</td>
<td>9766</td>
<td>0.7</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.7</td>
<td>9867</td>
<td>0.8</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.8</td>
<td>9968</td>
<td>0.9</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.9</td>
<td>9969</td>
<td>1.0</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.10</td>
<td>9770</td>
<td>1.1</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.11</td>
<td>9771</td>
<td>1.2</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.12</td>
<td>9772</td>
<td>1.3</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.13</td>
<td>9773</td>
<td>1.4</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.14</td>
<td>9774</td>
<td>1.5</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.15</td>
<td>9775</td>
<td>1.6</td>
<td>CMCSIdle</td>
<td></td>
</tr>
<tr>
<td>Line 5.16</td>
<td>9776</td>
<td>1.7</td>
<td>CMCSIdle</td>
<td></td>
</tr>
</tbody>
</table>
Lines (Active)
Displays diagnostic data on all active calls handled by the IP Office exchange lines.

Calls
Displays diagnostic data on all active calls handled by the IP Office. Yellow marker indicates incoming calls, red indicates internal calls and blue indicates outgoing calls.
Archiver

Archiver obtains and accumulates the information from the telephone system via the Delta Server. The Delta Server resides on a Server PC, the name of which will have been defined during installation (typically ARCHIVERSQL).

The information on the screen is as follows:

- **Status**: Indicates the status of the Archiver.
- **Started**: Indicates the date and time Archiver was launched.
- **Last Msg At**: Indicates the last message received from the Delta Server.
- **Received**: Indicates the number of messages received from the Delta Server during this session.
- **In Queue**: Indicates the number of messages waiting to be stored in the database.
- **Indexed**: Indicates the number of messages that have been indexed.
- **Rejected**: Indicates the number of messages that were rejected by the Archiver because of corruption or invalid message in the telephone system database. Rejected is incremented when an SMDR is corrupted owing to external factors (e.g. cable breakage, or data corruption in the database). This figure should never increment. If it does, it is advisable to check all cables, network setting, names in the database, etc. Occasionally SQL problems can also cause an increase in this number. If this occurs, check the System and/or SQL Events Log.
- **Database Server**: The name of the SQL server.
- **Delta Server**: The name of the delta server.
- **Metrics**: Indicates the number of SMDR messages received by the Archiver.
- **Activities**: Indicates the number of Agent activity messages received by the Archiver. This figure will be considerably higher than the Archiver Metrics figure.
- **Call Flow**: Indicates the number of Call Flow messages received by the Archiver. Call Flow metrics are only available when configured in Voice Mail.
Reporting Admin Console

The Reporting Admin Console is a windows application which runs on the machine that hosts the Reporter application. The window containing a series of tabs that enable configuration settings to be specified for the report server windows service and web applications. The application is automatically installed and completed during the installation process.

Launching Reporting Admin Console
1. Click the Start button on the Windows Taskbar.
2. Point to Programs | CCC.
3. Select CCC Reporting Admin Console.

PBX Tab
Enter the IP Address of the IP Office that contains the licence information.

![Image of CCC Reporting Admin Console window with PBX tab selected and an IP Office Address field showing 192.168.42.20]
Database Tab

The machine that holds the historical call data database is detailed on the Database Tab. The authentication credentials used for connecting to the database can be maintained.

If SQL Server authentication and the database user id fields are left empty then the default name SDXArchiver is used for connecting to the database. If you want to connect to another database server, enter the name and password of the new target.

For the SQL Server Security field, enter both the name and password entered whilst installing MSDE 2000 (the defaults are sa and NMYSBH). If you have connected to a different database server, enter the name and password.

Note: If you are using Windows integrated security and the web.config file for the web application has the setting identity impersonate set to true then the credentials of the client using the web application will be used to connect to the database. For preset reports, the credentials under which the report server windows service is running will be used to connect to the database.
**CRM Tab**
Details of the machine that hosts an instance of MSCRM needs to be entered. The date and time formats that are used by the MSCRM as specified in the Calendar tab of the system settings dialog. The date and time formats must be set correctly so that any reports that contain date and time information from MSCRM run correctly.

![CRM Tab](image1.png)

**Email Tab**
The name of the SMTP server that is used for any email distribution tasks needs to be specified. The value specified in the email address field is used in the email From field. It is not possible for the report server to receive email messages.

![Email Tab](image2.png)
Service Tab
Specify the TCP port number that the web application uses to communicate with the windows service.
Database Server Supervisor

The Database Server Supervisor provides the ability to backup and restore the Report Manager databases as well as manage the Archiver Database Maintenance Plan when using a MSDE 2000 database. It needs to be run on the PC that Report Manager has been installed onto. However, it is possible to install and use from a PC containing Microsoft Windows 98/NT4/2000.

The backup and restore facility provides an important safeguard for protecting critical data stored in the MSDE databases. Backing up and restoring databases is also useful for non-system problems, such as moving or copying a database from one server to another.

Backups will usually be scheduled and specified through the Maintenance Plan, however you can create additional backups using either the Wizard or manual backup option.

Starting

To launch the Database Server Supervisor:

1. Make sure that the SQL Service Server Manager is running.
2. Click the Start button on the Windows Taskbar.
3. Point to Programs and then to CCC.
4. Select Database Server Supervisor from the sub-menu.
5. When the Database Server Supervisor is started, a SQL Server Login dialogue box is displayed. Either, enter the name of the server to be connected to and the login id and password or tick the Use Windows Authentication box and the click OK.

Once connected to a database server, the available options are determined. This can take several seconds.

Note: If a connection cannot be made to the database server, an error message is displayed. If you click on the Cancel button, the application will stop. By clicking on the OK button the server login dialogue box will be displayed again.

Changing the Server Connection

The server that the application is connected to can be changed from within the program.

To change the server connection:

1. From the File menu select Server Connection.
2. Complete the information required in the SQL Server Login dialogue box and click on the Ok button.

Note: If a connection is made to a SQL Server other than the existing one, the options tree is reloaded. If no connection is made to another server, the existing connection continues.
## User Interface

The Database Server Supervisor window is displayed showing the Options and Information Panes. If no details are shown in the Information pane, expand the options tree and select any folder or file.

The toolbar displays the status of the application and the name of the server to which the application is connected.

**Note:** The language in which the options tree is displayed depends upon the regional settings selected for Windows. If the regional setting selection is not supported then the options tree will be displayed in English. The application's windows and menus will be displayed in the same language as the options tree.

## Options Pane

The Options Pane contains the options tree whose content and associated menus will depend upon the server installation.

![Database Server Supervisor](image)

Menu options depend on which option is selected within the tree structure. The menu list can be accessed by right clicking an option or by highlighting the option and selecting the Edit menu on the menu bar. When a selected option has no associated menu, the Edit menu bar is unavailable for selection. For more information about the properties, please refer to the section Properties.

The information displayed and the menus associated with the information are listed below.

<table>
<thead>
<tr>
<th>Selected Option</th>
<th>Information Description</th>
<th>Associated Menus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>List of options one level below (Databases / Management)</td>
<td>Backup Database; Restore Database &amp; Properties</td>
</tr>
<tr>
<td>Databases</td>
<td>List of databases</td>
<td>Backup Database, Restore Database and Properties</td>
</tr>
<tr>
<td></td>
<td>Database Name - Database Statistics information</td>
<td>Backup Database, Restore Database and Properties</td>
</tr>
<tr>
<td>Management</td>
<td>List of options: SQL Server Agent; Backup; Database Maintenance Plans; SQL Server Logs.</td>
<td>Backup: New Backup Device; SQL Server Agent: Display Errorlog</td>
</tr>
<tr>
<td></td>
<td>SQL Server Agent - List of options one level below (Jobs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Jobs – List of maintenance tasks</td>
<td>Start Job; Stop Job; &amp; Job History</td>
</tr>
<tr>
<td></td>
<td>Backup - List of backup devices</td>
<td>Delete &amp; Properties</td>
</tr>
</tbody>
</table>
### Information Pane

The Information Pane displays details according to the selection made in the options tree. Any folders that are selected show the list of files within the folder.

If a database is selected then the information pane shows details about both the database and the associated transaction log. The information includes details of when the last backup occurred and a pie chart showing the space used and available space. An example can be seen below.

![Database and Transaction Log Example](example.png)

If the file Jobs (Management/SQL Server Agent) is selected, a list of scheduled jobs can be seen. The Backup file shows the available backup devices. The Database Maintenance Plans file shows the pre-installed Archiver Maintenance Plan.

In the SQL Server Logs folder the Database Supervisor Activity is recorded.

You can refresh the display by selecting **Refresh** from the **File** menu. The refresh option is also displayed in all options tree and information area popup menus. If selected it will cause the currently active selection to be refreshed. Options that are below the selected option are also refreshed.

To view the properties of a database:

1. Click on the database name within the options pane.
2. Right mouse click within the information pane and select **Properties** from the menu.
Archiver Maintenance Plan

When the Archiver database is installed, an associated maintenance plan is created. This maintenance plan is preset to run optimisation, integrity check and backup jobs. Each of these jobs may be run manually by selecting the 'Jobs' option. Using the Archiver maintenance plan, each associated job's properties can be altered and preferred scheduling parameters can be set.

To amend any details in the Archiver Maintenance Plan:

1. Open the **Management** folder.
2. Open the **SQL Server Agent** folder.
3. Select **Database Maintenance Plans**.
4. In the Information Pane double click on the words, **Archiver Maintenance Plan**. The Database Maintenance Plan screen will show.

Notes:

1. When changes made to the plan have been completed, click on the Apply button and then the OK button to update the maintenance plan.
2. You may not be able to amend the backup schedule and location within the Archiver Maintenance plan. If you require to create a different backup schedule use the backup wizard facility.

**General Tab**

The Pre-installed Maintenance Plan is called **Archiver Maintenance Plan** and the selected database is SDXArchiver. You can re-name the plan from this area as well as select or de-select other databases. By doing this you will only update the plan, not create a new one.

![Database Maintenance Plan Screen](image)

*Image of the Database Maintenance Plan screen showing the selected databases.*
Optimization Tab

The default settings are configured so that the SDXArchiver Database has the statistics used by the query optimizer updated every week on a Sunday at 00:00:00 (12am in US mode). The sample size of the database used is 10%. This part of the maintenance plan can be seen in the Job listing as: **Optimization Job for DB Maintenance Plan SDXArchiver**.

This tab controls whether to reorganize both data and index pages. Statistics can be updated by the query optimizer and any unused space from the database files can be removed.

![Database Maintenance Plan](image)

To amend the scheduling parameters for optimization click on the button labeled 'Change'.
Integrity Tab

The default settings are configured so that the SDXArchiver Database's integrity, including indexes are
checked every week on a Sunday at 00:00:00 (12am in US mode). This part of the maintenance plan
can be seen in the Job listing as: Integrity Checks Job for DB Maintenance Plan SDXArchiver.

This tab provides the ability to check the database integrity, including indexes and attempt to repair any
minor problems found during checking. Integrity checking can be set to happen before backing up the
database or transaction log. To amend the scheduling parameters click on the button labeled 'Change'.
Complete Backup Tab

The default settings are configured so that the SDXArchiver Database is backed up and the integrity of the backup is checked upon completion. The backup file is written to the default backup directory. This part of the maintenance plan can be seen in the Job listing as: **DB Disk Backup Job for DB Maintenance Plan SDXArchiver**.

The backup criteria can be amended in the maintenance plan. You have the ability to:

- Verify the integrity of the backup upon completion,
- Backup to tape or disk.
- Specify the directory to store the files and create a sub-directory for each database if backing up to a file.
- Perform housekeeping so those files over a certain age are deleted. In default mode the files will be removed after 4 weeks.
- Amend the scheduling parameters by clicking the button labeled 'Change'.
Transaction Log Backup Tab

By default, the Transaction Log backup is not selected. If you require to backup any transactions that occur between backups, you need to select this option and select the required parameters. The backup will have the file extension of .TRN. If created, this part of the maintenance plan will appear in the Job listing as: Transaction Log Backup Job for DB Maintenance Plan SDXArchiver.

To amend the scheduling parameters click the button labeled 'Change'.
Reporting Tab

By default no options are selected.

- **Text reports**
  A report can be written as a text file into a specified directory. The reports can then be e-mailed to an operator if required. Automatic housekeeping can be performed by selecting that reports are deleted when they are a certain age.

**Adding New Operators**

If an email report is to be sent to an operator, the operator details need to be added. Once the details have been added the operator can be selected from a drop down list.

To add a new operator click on the **New** button. The New Operator Properties dialog box appears. There are two tabs available.

- **General Tab** - Add the person's name and email address
- **Notifications Tab** - Select which notifications are to be sent to the operator and whether an alert or job should be emailed.
History

This can be written to either the current server in the table 'msdb.dbo.sysdbmaintplan_history' or to a remote server whereby you specify the location. History can be limited to a specific number of rows. To view the history tables, click on the View History button.

To see all the details of a Maintenance Plan:

1. Click on the Maintenance Plan in the list.
2. Click Properties.
3. A Database Maintenance Plan History Entry dialog will show, see example.
Edit Recurring Job Schedule

Occurs:

- **Daily**: Enter the amount of days (between 1 and 366) that you want the backup to run, i.e. for a backup to occur every other day enter the number 2.

- **Weekly**: Enter the number of weeks (between 1 and 52) that you want the backup to occur i.e. for a backup to occur once every three weeks enter the number 3. You also need to select the day of the week for the backup to occur.

- **Monthly**: Enter number of the day (between 1 and 31) and then the month number (between 1 and 99) that you want the backup to run. For example if you wanted a backup taken on the 15th of every other month you would enter the day number as 15 and the month number as 2. OR You can select the 1st, 2nd, 3rd, 4th, or last day (Mon-sun) of a month (1-99), i.e. to backup every month on the first Friday you would select the 1st option, the day as Friday and the month number as 1.

Weekly:

Select the weekly frequency and the day of the week that you want the backup to run.

**Daily Frequency**:

- **Occurs at**: Enter the time for the backup to start.

- **Occurs every**: Choose the hour (between 1-24) and then enter the start and end times.

**Duration**:

- **Start Date**: Enter the date for the first backup to happen.

- **Finish**: Enter the date for the last backup or if you do not want to specify a finish date choose the option *No end Date.*
Backups & Restoring

The Backup Wizard

The backup wizard allows you to specify the type of backup that you want to perform i.e. whether to overwrite an existing backup or only add the new data. You are also able to verify that the backup has been successfully completed and control where the data is stored.

To access the backup wizard go to the File menu and click on the Backup Wizard option. The following steps explain the information that needs to be completed.

1. At the Welcome screen click on the Next button to continue.
2. Select the database that you want to backup from the drop down list then click on the Next button to continue.
3. Enter a name and description for the backup and click on the Next button to continue.
4. Select the type of backup you want to make, i.e. do you want to backup the entire database or only the new or changed data. Click on the Next button to continue.
5. Select where you want the backup to be stored. You can choose to backup to a file or to any backup device that is available. In this section you can also select whether to overwrite the backup media or append. If you want to read and verify the integrity of the backup when completed, select the option on this screen. Click on the Next button to continue.
6. The Backup Verification and Scheduling screen will appear. You are able to schedule when the backup should occur. To amend the schedule select the box to the left of Schedule and then click on the Change button. The Edit Schedule screen will show.
7. Click on the Next button to continue.
8. The final screen shows the backup information that you have defined. If you want to make any alterations click on the Back button to go back through the wizard. If you do not want to make any changes click on the Finish button to continue.
9. If your backup requirements were completed correctly, a screen will show stating that the backup job has been created successfully.
The Edit Schedule Screen allows you to specify the occurrence, frequency and duration of a task. Enter the required details and then click on the Ok button to continue.

The schedule type can be one of the following:

- Start automatically when SQL Server Agent starts.
- Start whenever the CPU(s) become idle.
- One Time (enter the date and time for the backup to occur once).
- Recurring. If you choose this option, you will need to set the occurrence, frequency and duration of the backup. Click on the Change button to view the list of options. An explanation of the options is shown below.

**Occurrence**

- **Daily**
  Enter the amount of days (between 1 and 366) that you want the backup to run, i.e. for a backup to occur every other day enter the number 2.

- **Weekly**
  Enter the number of weeks (between 1 and 52) that you want the backup to occur i.e. for a backup to occur once every three weeks enter the number 3. You also need to select the day of the week for the backup to occur.

- **Monthly**
  Enter number of the day (between 1 and 31) and then the month number (between 1 and 99) that you want the backup to run. For example if you wanted a backup taken on the 15th of every other month you would enter the day number as 15 and the month number as 2. OR You can select the 1st, 2nd, 3rd, 4th, or last day (Mon-sun) of a month (1-99), i.e. to backup every month on the first Friday you would select the 1st option, the day as Friday and the month number as 1.

**Daily frequency**

- **Occurs at:** Enter the time for the backup to start.
- **Occurs every:** Choose the hour (between 1-24) and then enter the start and end times.

**Duration**

- **Start:** Enter the date for the first backup to happen.
- **Finish:** Enter the date for the last backup or if you do not want to specify a finish date choose the option *No end Date.*
Manual Backups

You can create backups without using the Wizard. To backup a database make sure that a database in the Options pane is selected then:

1. From the Edit menu select Backup Database.
2. When you have specified all the criteria for the backup click on the OK button.

**Note:** If you do not want to backup a complete database, you can backup only new or changed data by selecting Differential database Backup. Backup types 'Transaction Data' and 'File and Filegroup Data' are not available in the manual or wizard backups. However, transaction data can be backed up via the Archiver Maintenance Plan.

The General tab allows you to:

- Select the database that you want to backup from the drop down menu.
- Enter a name for the backup and a brief description.
- Select whether you want to backup a complete database or differential.
- Select the destination of where you want the database to be backed up to i.e. tape drive or disk.
- Select whether to overwrite the existing data or not.
- If you require to schedule the backup, click in the box the left of the word schedule.

![SQL Server Backup - SDXArchiver](image)

1. From the Edit menu select **Backup Database**.
2. When you have specified all the criteria for the backup click on the **OK** button.

**Note:** If you do not want to backup a complete database, you can backup only new or changed data by selecting Differential database Backup. Backup types 'Transaction Data' and 'File and Filegroup Data' are not available in the manual or wizard backups. However, transaction data can be backed up via the Archiver Maintenance Plan.

The **General** tab allows you to:

- Select the database that you want to backup from the drop down menu.
- Enter a name for the backup and a brief description.
- Select whether you want to backup a complete database or differential.
- Select the destination of where you want the database to be backed up to i.e. tape drive or disk.
- Select whether to overwrite the existing data or not.
- If you require to schedule the backup, click in the box the left of the word schedule.
Click on the **Options** tab. From this area you can choose to:

- Verify the backup data when completed.
- If backing up to a tape device you can select to eject the tape when completed as well as clearing the contents on a tape and then labeling the tape with a name and description.
Restoring a Database

Restoring a database returns the database to the same state it was in when that backup was created.

**CAUTION:** Maintenance installation of the CCC may be required if the Database is restored from a backup taken from another Server. Refer to the CCC Installation Manual for details.

To restore a database:

1. Make sure that the Archiver application is not running.
2. In the Options Pane, highlight the relevant database.
3. Click on the **Edit** menu and select **Restore Database**. The restore database screen will show.
4. The **General** tab allows you to:
   - Select the database that you want to restore over from the drop down list.
   - Select what you want to restore i.e. a database.

   ![Restore database dialog box]

   In the parameters section you need to: Select the database backup that you want to restore. A list of backups from different date's etc. will show. From the drop down list, select the backup that you want to restore.

5. Make sure that the **Options** tab is at the front then:
   - Check that the Original file name being restored is correct.
   - Select any of the options required in the recovery completion state section.
6. Click on the Ok button to start the restore process.

7. A restore progress screen indicates the progress of the restore. An information screen appears when the restore has been completed successfully.

8. Restart the Archiver application.
General Information

Display Error Logs

Error messages as well as information and warning messages can be viewed. The message types are identified by a symbol, as shown below.

- Error Message.
- Warning Message.
- Information Message.

1. In the Options Pane open the folder called Management. Right Mouse click on the words SQL Server Agent and select the option Display Error log.

2. The SQL Server Agent Error Log screen will show.

   ![SQL Server Agent Error Log](image)

   1. Select the type of messages to be searched.
   2. Enter the text to be found in the text box.
   3. Click on the Apply Filter button.

3. Any error message will be shown in this screen as well as warning and Information messages. To view a certain type of message, select the type from the drop down list.

   If there is certain text that you want to find in the messages you can apply a filter to view only the messages that contain the required text. To apply a filter:

   1. Select the type of messages to be searched.
   2. Enter the text to be found in the text box.
   3. Click on the Apply Filter button.

   To see more view more of a message, double click it.
Viewing Messages

The data shown in the screen indicates the type of message, the date and time it was created and part of the description. If the whole description cannot be seen you will need to double click on the message and a properties screen shows detailing the message type, date and the full message text. The 'Next' and 'Previous' buttons allow a user to scroll through all the messages.
Jobs

Viewing Jobs & the History
Open the Management folder and then the SQL Server Agent folder. Select the file called jobs. The information pane will show a list of jobs that have been scheduled. Further information can be obtained by double clicking a job.

The job history screen shows the
- Job name.
- The dates and time it was run.
- The result i.e. whether it was successful or the job failed.
- Any notifications that occurred.
- How long the job run took to run in hours, minutes and seconds.
- The names of any operators who were emailed reports.
- Error and/or messages from the job i.e. the name of the user who invoked the job and the last step to run.

To show the step details within the main screen, check the box next to the wording 'Show step details'.

To clear the history of a job click on the **Clear All** button. A warning dialogue box will show asking you to confirm that you want to clear the history.

Controlling Jobs
You can manually start or stop a job. Right mouse click on the required job within the Information pane and from the pop up menu select to start a job or stop a job.

**Note**: Jobs cannot be deleted. Any Jobs showing in the Jobs file that related to the Archiver Maintenance Plan can be amended or removed if you change the Maintenance Plan.
Backup Devices

Installing Backup Devices

When a new backup device is fitted, the Database Server Supervisor has to be updated. To do this:

1. From the Options pane open the Management folder.
2. Right mouse click on Backup and select New Backup Device from the menu. The 'Backup Device Properties - New Device' screen is shown. Complete the details and then click on the Ok button.

Removing Backup Devices

To remove any backup devices:

1. From the Options pane open the Management folder and select Backup
2. In the Information Pane select the required backup device and right mouse click on the device to view the pop up menu.
3. Select the option Delete to remove the selected backup device.
Properties
You can see the properties of a database by:

1. Select the required database within the Options Pane.
2. From the **Edit** menu select the option **Properties**.

Or

1. Click on the database name within the Options pane.
2. Right-click within the Information pane and select **Properties** from the pop-up menu.

General Tab
The general tab shows:

- The name of the database whose properties are being viewed.
- General information about the database including Status, owner, date it was created, size, space available and number of users.
- Details of when the last backup and transaction log backup occurred.
- Details of whether a maintenance plan has been set up and the collation type.
Data Files Tab

The Data files tab shows:

- The file name, location, allocated space and filegroup of the database.
- Details of the file properties, which includes whether the file will grow automatically and details of file growth in either megabytes or percentage terms. It also shows if there is unrestricted or restricted file growth and if so the size in megabytes.

Within this tab you can amend the file growth details as well as delete any data files selected in the listing.
Transaction Log Tab

The Transaction log shows:

- The file name location and allocated space for the transaction log files. Transaction log files have the extension TRN.
- Details of the file properties, which includes whether the files will grow automatically and details of the file growth in either megabytes or percentage terms. It also shows if there is unrestricted or restricted growth and if so the size in megabytes.

Within this tab you can amend the transaction log file growth details as well as delete any data files selected in the listing.

File Groups Tab

Not currently supported.
Options Tab

Within this tab you can control the following:

- **Access**
  Access to the database can be restricted to a single user i.e. only one user at a time can access the database, or to members of db owner, dbcreator, or sysadmin. You are also able to specify that users can retrieve, but not modify, data from the database by making the database read only.

- **Recovery**
  Select the type of recovery model for the database. For more information please refer to the SQL 2000 manual.

- **Settings**
  The database settings which can be set in this area are:
  - **ANSI NULL default**
    Specify whether database columns are defined as NULL or NOT NULL by default.
  - **Recursive triggers**
    Enable recursive firing of triggers.
  - **Auto update statistics**
    Specify that out-of-date statistics needed by a query for optimisation are built automatically during optimisation.
  - **Torn page detection**
    Specify that incomplete pages can be detected.
  - **Auto Close**
    Specify that the database is shut down after its resources are freed and all users exit.
  - **Auto Shrink**
    Specify that the database files are candidates for automatic periodic shrinking.
  - **Auto Create statistics**
    Specify that any missing statistics needed by a query for optimisation are built automatically during optimisation.
  - **Use quoted identifiers**
    Specify that SQL Server enforces ANSI rules regarding quotation marks. Select this option to specify that double quotation marks must only be used for identifiers, such as column and table names. Character string must be enclosed in single quotation marks.

- **Compatibility**
  Allows you to specify the database compatibility level.
From the permissions tab you are able to set permissions for each user/role. Details of the permissions are shown below.

- **Create Table**
  Specify whether permission to create a table is granted for each user or role.

- **Create View**
  Specify whether permission to create a view is granted for each user or role.

- **Create SP**
  Specify whether permission to create a system procedure is granted for each user or role.

- **Create Default**
  Specify whether permission to create a default is granted for each user or role.

- **Create Rule**
  Specify whether permission to create a rule is granted for each user or role.

- **Create Function**
  Specify whether permission to create a function is granted for each user or role.

- **Backup Database**
  Specify whether permission to create a backup database is granted for each user or role.

- **Backup Log**
  Specify whether permission to create a backup log is granted for each user or role.
Administering the Database

Overview
If you have installed the MSDE database, four scheduled tasks are installed automatically. The parameters cannot be configured. Listed below is a description of each scheduled task's function. If you have purchased and installed Microsoft SQL 2000 you can use the tools provided to create and schedule backups etc.

- **Note**
  If the program 'Database Server Supervisor' has been installed, you are able to use the tools provided within it to create and schedule backups.

---

**Disk Backup**
This task is enabled by default and scheduled to run once a week on a Sunday at 2 am. It backs up the SDXArchiver database to the default backup directory, which is d:\microsoft sql\server\mssql\backup. At the same time any backup that is more than 4 weeks old is deleted.

---

**Integrity Check**
This task is enabled by default and is scheduled to run once a week on a Sunday at 1 am. It checks for any problems/corruption in the SDXArchiver database and automatically fixes any minor faults that are found without affecting any data.

---

**Optimizations**
This task is enabled by default and is scheduled to run once a week on a Sunday at 1 am. For each table in SDXArchiver, a 10% sample of the data is taken and used to update the statistics used by the query optimize (an engine used to analyze queries and determine the quickest way to return the data being queried for).

---

**Restore**
If you need to restore the database from a backup created above, please contact your field engineer for help.

---

**Tape Backup**
This task is disabled by default and cannot be used when only the MSDE database is installed.
# Index

## A
- Administering
  - Database .......................................................... 63
  - Administering .................................................. 63
  - Agents .................................................................. 22, 23
  - Agents Available ................................................ 24
  - Agents Located .................................................. 24
  - Archiver Maintenance Plan .................................... 40
- Backup Wizard ..................................................... 48

## B
- Backups .................................................................. 50
- Backup Wizard ..................................................... 48
- Bank ....................................................................... 24
- Backup ..................................................................... 48
- Backup Wizard ..................................................... 48
- Backup Wizard ..................................................... 48

## C
- Calls ....................................................................... 30
- Changing
  - Server Connection .............................................. 37
  - Changing .............................................................. 37
  - Comms .................................................................. 18
  - Complete Backup Tab ........................................... 43
- Controlling
  - Jobs ..................................................................... 56
  - Controlling ........................................................... 56

## D
- Data Files Tab ......................................................... 59
- Database
  - Administering ...................................................... 63
  - Restoring ............................................................... 52
- Database.................................................................. 52, 63
- Database Server Supervisor ...................................... 40, 58
- Delta Server
  - Launching ............................................................. 11
- Delta Server ............................................................. 11
- Delta Server Introduction ......................................... 10
- Disk Backup ............................................................ 63
- Display Error Logs .................................................. 54

## E
- Edit Schedule Screen .............................................. 49
- Email Notification ................................................... 15
- Event Viewer ............................................................ 13
- Event Viewer Selector .............................................. 14

## F
- File
  - Log ...................................................................... 16

## G
- General ..................................................................... 5
- General Tab ............................................................ 40, 58
- Group ....................................................................... 28
- Group Active ............................................................ 28
- Groups Tab ............................................................... 60

## H
- History ..................................................................... 56

## I
- Integrity Check .......................................................... 63
- Integrity Tab ............................................................. 42
- Introduction ............................................................. 5, 31

## J
- Jobs
  - Controlling ........................................................... 56
  - Viewing ................................................................... 56
  - Jobs ....................................................................... 56

## L
- Launching
  - Delta Server .......................................................... 11

## M
- Manual ..................................................................... 6
- Manual Backups ...................................................... 50
- Message Control ..................................................... 19
- Messages
  - Viewing ................................................................... 55
  - Messages ............................................................... 55

## O
- Optimisation Tab ..................................................... 41
- Optimizations .......................................................... 63
- Options Tab ............................................................. 61
- Overview ................................................................... 63

## P
- PCA Target Times ..................................................... 20
- Permissions Tab ....................................................... 62
- Pilot Number ............................................................ 29
- Properties ............................................................... 58

## R
- Recent SMDR Entries .............................................. 25
- Reporting
  - Tab ....................................................................... 45
- Reporting ............................................................... 45
- Restoring
  - Database ............................................................... 52
  - Restoring ............................................................... 52, 63

## S
- Server Connection
  - Changing ............................................................... 37
- Server Connection .................................................... 37
- Session Info ............................................................ 27
- SMDR ...................................................................... 17
- System Overview .................................................... 7

## T
- Tab
  - Reporting ............................................................... 45
  - Tape Backup ........................................................... 63
  - Transaction Log Backup Tab ..................................... 44
  - Transaction Log Tab ................................................. 60

## U
- Use .......................................................................... 6
- User Interface ........................................................ 38
- Users ....................................................................... 21

## V
- Viewing
  - Jobs ..................................................................... 56
  - Messages ............................................................... 55
  - Viewing ................................................................. 55, 56
Performance figures and data quoted in this document are typical, and must be specifically confirmed in writing by Avaya before they become applicable to any particular order or contract.

The company reserves the right to make alterations or amendments to the detailed specifications at its discretion. The publication of information in this document does not imply freedom from patent or other protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

This document contains proprietary information of Avaya and is not to be disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to "wgctechpubs@avaya.com".

© 2005 Avaya Inc. All rights reserved.

Avaya
Sterling Court
15 - 21 Mundells
Welwyn Garden City
Hertfordshire
AL7 1LZ
England

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933